
Tutorial in US and SI Units 

This tutorial will take you through the process of modeling a small piping system from start to finish and 

demonstrate most of the program features. New users are strongly encouraged to run through the tutorial. 

The tutorial is written with the U.S. customary units shown first followed by the equivalent value in S.I. units. 

Create and Save a New Project 

It is recommended that you save your new project as soon as it is created. 

1. Open the software and create a new project file: 

a) Click the New File button in the Main Toolbar, or 

b) Go to the File Menu and select New. 

2. Save the file with the desired name and location: 

a) Click the Save File button  in the Main Toolbar or go to the File Menu and select Save or 

Save As. 

b) Navigate to the Projects folder and enter North-South Transfer System in the File name field. 

c) Click the Save button to create the project file. 

Customize the User Interface 

The User Interface consists of Menus located above the FLO-Sheet, along with Toolbars and Windows that 

can be displayed, hidden, or docked anywhere around the FLO-Sheet.  

Show and Hide a Toolbar and Window: 

1. Toolbars 
a) In the View Menu, hover over Toolbars and select the Toolbar to display it (checked) or to 

hide it (un-checked). 

2. Windows 
a) For a Window that is being displayed, it can be hidden from the View Menu or by clicking on 

on the right side of the Window title bar. 

b) Alternatively, Right Click on any Toolbar or the title bar of any displayed Window to open a 

drop down list of all available Toolbars and Windows. Click on the desired Toolbar or 

Window to show or hide it. 

Dock and Undock a Toolbar and a Window: 

1. Toolbars 
a) Click and hold down the left mouse button on the dotted separator line at the beginning of a 

Toolbar. 

b) Dock the Toolbar by dragging it to the far right, far left, top and bottom of the workspace until a 

blue rectangle appears to indicate where the Toolbar can be docked, then release the mouse 

button to dock it at that location. 

c) Undock the Toolbar by releasing the mouse button anywhere except on the blue rectangle. 



2. Windows 
a) Click and hold down the left mouse button on the Message Window title bar. 

b) Dock the Message Window by dragging it around the workspace until a blue rectangle appears 

to indicate where the Window can be docked, then release the mouse button to dock it at that 

location. 

c) Drag the Message Window and place it on top of the List View Window to create tabbed 

Windows. Click the tabs at the bottom to switch between the two Windows. 

d) Undock the Message Window by clicking on on the right side of the title bar, or by dragging 

and dropping the Window anywhere except on the blue rectangle 

Adjust the Size of an Undocked Window 

1. Undock the Message Window. 

2. Click on a corner or edge of the Window. 

3. Drag the corner or edge until the Window is at the desired size. 

Set up the FLO-Sheet 

 
There are several options to determine how the FLO-Sheet will look and what information will be displayed on 

the FLO-Sheet. 

Define the Grid Settings 

To customize how the FLO-Sheet will look: 

1. Click on an empty space on the FLO-Sheet. 

2. In the Property Grid, click the triangle beside Grid Settings and set the following: 

a) Grid Type: Orthogonal (the other option is Isometric) 

b) Grid Spacing: Fine (the other options are Standard and Coarse) 

c) Show Grid: check the box to show the grid 

d) Snap to Grid: check the box to snap to grid 

Set the Device View Options 

1. To customize the amount of information to display on the FLO-Sheet for each Device: Click on an 

empty space on the FLO-Sheet.  



2. In the Property Grid, click the triangle beside Device View Options  

a) Expand the section for each Device, then expand the FLO-Sheet Text and check the selection 

box for each parameter to display. 

b) Expand the Valve and Fittings Symbols section and check the box beside all the types to 

display on the FLO-Sheet.  

 

 

 

 

Define the Authorship Settings 



1. In the Property Grid for the FLO-Sheet, click the triangle beside Authorship 

2. Enter your Company name 

3. Enter the following Project name: North-South Transfer System 

4. Enter your name as the Author 

 

Define Calculation Settings 

1. In the Property Grid for the FLO-Sheet, click the triangle beside Calculation Settings. 

2. For the Calculation Method select Darcy-Weisbach (other option is Hazen-Williams). 

3. Leave the following settings at their default values. These can be changed if the software cannot 

converge to a solution. 

a) % Tolerance: 0.01% 

b) Max Iterations: 100 

c) Linear Switch Point: 10% 

d) Laminar Cutoff Re: 2100 

e) Force Laminar Calculations: Unchecked 

 

 

 

Define the Document Units 



 
The project Document Units are used as the default units for the displayed results on the FLO-Sheet, the 

calculated results in the Property Grid, and the user-entered Design Data for all Devices in the Property 

Grid. 

Define the Document Units: 

1. Click the System Menu and select Units to open the Adjust Document Units dialog box. 

2. In the Adjust Document Units dialog box: 

a) Set the Pressure Reference to gage. 

b) Click  to open the Calculate Atmospheric Pressure dialog box 

i. Enter an Elevation of 500 ft (152 m) 

ii. Click  to close the dialog box. 

 
iii. Review the calculated value of Atmospheric Pressure. 

iv. Over-ride this value by entering 14.7psia (101 kPa). 

v. Note that the unit for Atmospheric Pressure can be changed with the drop down menu. 

c) Select Volumetric as the Flow Rate Type 



 

d) Click to open the Custom Units dialog box.  

i. Enter Smoot^3/sec in the Unit Label field for a custom Volumetric Flow Rate. 

ii. Enter 2.38e8 for the Conversion Factor. 

iii. Click to close the Custom Units dialog box. 

iv. Click the drop down menu of the Volumetric Flow unit and scroll down to see that the 

Custom Unit is now available to choose from. 

v. Select gpm for the Volumetric Flow rate unit. 

3. Click the drop down menu for a list of available units for each quantity. Accept the default units at this 

time. 

4. Click  to close the Adjust Document Units dialog box. 

Define a Fluid Zone 

 



Fluid Zones provide key fluid property information for calculations throughout the model. 

1. Click the System Menu and select Fluid Zones to open the Fluid Zones dialog box. 

2. Click to open the Fluid Properties dialog box. 

3. Enter Water at 60 F and 75 psig (Water at 15 C and 517 kPag) in the Fluid Zone Name field. 

4. Select Table Fluid as the Type (other option is Custom Fluid) 

5. Scroll down the list of Installed Fluid Tables and select Water. 

6. Specify 60 °F (15 °C) in the Temperature field. 

7. Specify 75 psig (517 kPa) in the Pressure field. 

a) The software calculates the remaining fluid properties using the formulas in the Fluid Table. 

b) Note the values of Density, Viscosity, Vapor Pressure, and Critical Pressure (Specific Heat 

Ratio and Relative Molecular Mass are calculated if the fluid is a gas or vapor.) 

8. Click to close the Fluid Properties dialog box 

9. Click to close the Fluid Zones dialog box. 

 

 

 



 

Define a Pipe Specification 

 

Pipe Specifications are used to define the pipe material, schedules, pipe sizes, the valves and fittings Valve 

Table, and the pipe Sizing Criteria and Design Limits. 

1. Go to the System menu and click Specifications to open the Pipe Specifications dialog box. 

2. Click to open the Pipe Properties dialog box. 

3. Type Steel Sched 40 in the Name field. 

4. Scroll down the list of the Installed Pipe Tables and click the arrow next to Steel A53-B36.10. 

5. Scroll down and select 40 from the list of available schedules. 

a) Note the values of Absolute Roughness and the Hazen-Williams C Factor are default values 

taken from the Steel A53-B36.10 Pipe Table and can be over-ridden if desired. 

b) Note the displayed Size Range for the Pipe Material and Schedules. 

 



 

6. In the Sizing Criteria drop down list: 

a) Select Design velocity (other options are Head Loss per 100 units of length or Pressure Drop 

per 100 units of length) 

b) Specify 8 ft/sec (2.4 m/s) in the Velocity field 

7. In the Design Limits fields: 

a) Specify 0 and 12 ft/sec (0 and 3.7 m/s) in the Velocitymin and max fields (respectively). 

b) Specify 0 and 285 psig (0 and 1965 kPag) in the Pressuremin and max fields (respectively). 

c) Specify 4000 in the Reynolds No min field and leave the max field blank 

8. Open the drop down menu for Valve Table and review the available Valve Table to choose from. 

Select the StandardValve Table. 

9. Click to close the Pipe Properties dialog box. 

10. Click to close the Pipe Specifications dialog box 

Draw the Piping System Model 

The PIPE-FLO Interface allows the piping system model to be drawn quickly by placing all the Devices on 

the FLO-Sheet without entering any Design Data. A default Device Name is automatically entered and 

incremented to create a unique name for each Device. The user can over-ride these names and enter their 

desired name when entering the Design Data. 

Alternatively, the user can draw each Device and then immediately enter the Design Data before adding 

another Device. 



The following procedure will have you draw the system first, then go back and enter the Design Data. 

Place All Devices on the FLO-Sheet 

Select the following Devices in the Toolbox window and place them on the FLO-Sheet roughly located 

according to the image:

 

1. A Tank on the FLO-Sheet  

2. A Sizing Pump  

3. A Curve dP Device  

4. A Flow Demand  

5. A Pressure Boundary  

Connect Devices Together with Pipelines 

Select Pipe in the Toolbox window and connect each Device together according to the drawing. 

When the cursor hovers over a Device the Cursor Indicator changes to four green arrows pointing in toward 

the Device if the connection is allowed, and to four red arrows if the Device already has the maximum number 

of pipes connected and the connection is not allowed. 



 

1. Tank to Sizing Pump 
a) Click on the first Tank on the left of the FLO-Sheet. 
b) Move cursor down and click on a grid line to create a vertex. 
c) Move the cursor to the right and click on the Sizing Pump to make the connection. 

2. Sizing Pump to Curve dP Device 

a) Click on the Sizing Pump. 

b) Move the cursor to the right and click on the Curve dP Device to make the connection.  
3. Curve dP Device to the Node 

a) Click on the Curve dP Device 
b) Move cursor to the right and double click to end the Pipe segment and create a Node. (this is another 

way of creating Nodes) 
4. Connect the Node to the Pressure Boundary 

a) Click on the Node to start another Pipe and move the cursor up and click on a grid line to create a 
vertex, then to the right and click on the pressure boundary to make the connection. 

5. Connect the Node to the Flow Demand 
a) Click on the Node to start another Pipe and move the cursor down and click on a grid line to create a 

vertex, then to the right and click on the Flow Demand to make the connection. 

NOTE: The Devices and Pipes can be moved around by selecting them and dragging them to the desired 

position. 



NOTE: Vertices can be added by holding down the SHIFT key and clicking on a Pipe. The vertex can be 

moved to the desired location. 

Enter Device Design Data 

Design Data can be entered individually or multiple Devices can be selected and Group Edited to quickly 

enter redundant data. 

The following steps will guide you through entering the Design Data individually and using the Group Edit 

feature. 

Enter the Tank Design Data 

The Tank Design Data includes key parameters and the Fluid Zone to use if there are two or more pipes are 

connected with different Fluid Zones. 

Design the Supply Tank 

1. Select the Tank on the left. 

2. In the Property Grid:  

a) In the Name field, enter Supply Tank. 

b) In the Elevation field, enter 20 ft (6 m). 

c) In the Surface Pressure field, enter 0 psig (0 kPa). 

d) In the Liquid Level field, enter 10 ft (3 m). 

e) In the Fluid Zone field, leave the value set to <Undefined> (this only needs to be specified if 

the connected Pipes have different Fluid Zones). 

f) Click in the Penetrations field to activate the button to open the Tank Penetrations dialog 

box. 

i. leave the Height set at the default value of 0 ft (0 m). 

ii. Click to close the dialog box. 

3. Notice that the Supply Tank text is now black, indicating that it is fully designed. 

Enter the Sizing Pump Design Data 

The Sizing Pump is used to calculate the Total Head of a Pump based on the hydraulic characteristics of the 

entire piping system.  

Design the Sizing Pump 

1. Select the Sizing Pump. 
2. In the Property Grid: 

a) In the Name field, enter Transfer Pump. 
b) In the Suction Elevation field, enter 0 ft (0 m). 
c) In the Discharge Elevation field, enter 0 ft (0 m). 
d) In the Flow Rate field, enter 800 gpm (182 m3/h) 

 



Enter the Curve dP Device Design Data 

The Curve dP Device is used to model equipment that has a Pressure Drop that varies with the Flow Rate 

through the equipment, which is the case for many Devices such as heat exchangers, filters, screens, etc. The 

Curve dP Device has a Curve Data Estimator to generate a second order curve based on a single user-entered 

Flow Rate and Pressure Drop data point. 

Design the Curve dP Device 

1. Select the Curve dP Device. 

2. In the Property Grid:  

a) In the Name field, enter Duplex Strainer. 

b) In the Inlet Elevation field, enter 75 ft (23 m). 

c) In the Outlet Elevation field, enter 75 ft (23 m). 

d) Click in the Curve field to activate the button. Click on to open the Curve Data dialog 

box. 

i. The default units displayed come from the Document Units but can be changed if 

desired. 

ii. In the Description field, enter Clean Strainer. 

iii. Click on the  to open the Curve Data Estimator dialog box. 

1. In the Static Pressure Drop field, enter 0 psi (0 kPa). 

2. In the Flow Rate field, enter 800 gpm (182 m
3
/h). 

3. In the Pressure Drop field, enter 10 psi (69 kPa). 

4. For the Maximum Flow Rate, enter 1600 gpm (363.4 m
3
/h). 

5. Click to close the Curve Data Estimator dialog box. Notice that the 

data table if filled out with values generated using a 2nd order curve. 

iv. Click to close the Curve Data dialog box. 

Enter the Pressure Boundary Device Design Data 

The Pressure Boundary is used to model equipment that has a given pressure at the boundary of a system. 

Design the Pressure Boundary Device 

1. Select the Pressure Boundary Device 
2. In the Property Grid:  

a) In the Name field, enter Pressure Boundary 
b) In the Elevation field, enter 85 ft (26m). 
c) In the Pressure Field enter 75 psig (517 kpa). 

Enter the Flow Demand Device Design Data 

The Flow Demand is used to model equipment that has a given flow requirement at the boundary of a system. 

The flow requirement can be either flow into the system or flow out of the system that you are modeling. 



Design the Flow Demand Device 

1. Select the Flow Demand Device 
2. In the Property Grid:  

a) In the Name field, enter Flow Demand 
b) In the Elevation field, enter 45 ft (14m). 
c) In the Flow Rate field, enter 100 gpm (23 m3/h). 
d) In the Flow Type field, select Flow Out. 

Enter the Node Design Data 

Nodes provide a location for connecting multiple Pipelines together and for providing a point in the system 

where the Pressure is calculated, making them useful for identifying the location of pressure gages in the 

piping system. 

Design the Nodes 

1. Select the Node at the outlet of the Duplex Strainer (Curve dP Device) 
2. In the Property Grid: 

a) In the Name field, enter PG-101. 
b) In the Elevation field, enter 0 ft (0 m). 

Enter the Pipe Design Data 

The Pipe Design Data includes key pipe and fluid properties and the ability to add valves and fittings that are 

installed in the Pipe. There are also options to Close the Pipe to simulate a closed valve. 

A Pipe Size Calculator is available to size the Pipe based on a Sizing Criteria that is selected in the Pipe 

Specification. 

Design the Pump Suction Pipe 

1. Select the Pipe between the Supply Tank and Transfer Pump 

2. In the Property Grid: 

a) In the Name field, enter Suction 

b) In the Fluid Zone field, select Water at 60 F and 75 psig(Water at 15 C and 517 kPa) from 

the drop down list 

c) In the Specification field, select Steel Sched 40 from the drop down list 

d) In the Size field, click the button to open the Pipe Size Calculator 

i. In the Design Flow Rate field, enter 800 gpm (182 m
3
/h) 

ii. The Calculated Size that will be closest to the Sizing Criteria is displayed (6 in) (or 150 

mm). 

iii. From the drop down list, choose 8 in(200 mm) instead since this is the pump suction 

piping (and we want to maximize NPSHa). 

iv. Click to close the Pipe Size Calculator. 

e) In the Length field, enter 45 ft (14 m) 

f) In the K (Valves & Fittings) field, click the button to open the Valve and Fittings dialog 

box 

i. Expand the Fitting section: 



1. Select Entrance - Sharp Edged and click to place it on the 

Installed list 

2. Select Elbow - Standard 90°, enter 3 for Count, then click to 

place them on the Installed list 

ii. Expand the Valve section and add 2 Gate valves individually: 

1. Select Gate - Knife, leave the Count as 1, then click to place it 

on the Installed list 

2. Select Gate - Knife, leave the Count as 1, then click to place it 

on the Installed list 

iii. Click to close the Valve and Fittings dialog box. 

iv. Notice the calculated K (Valves & Fittings) which is the sum of the Resistance 

Coefficients for all the installed Valves and Fittings 

v. Notice that the Suction Pipe shows the individual gate valves, but there is only one 

symbol representing all 3 elbows. The symbols can be moved along the Pipe for 

graphical purposes, or using the Device View Options the Valves & Fittings can be 

hidden. 

 

 

Group Edit Common Fields on the Remaining Pipelines 

3. Select all the Devices by Left Clicking above and to the right of the North Tank, holding down 

the Left Click and dragging the cursor to the bottom left of the FLO-Sheet (this draws a selection box 

around all of the Devices), then releasing the Left Click. All the Devices will be selected and the 

Property Grid will display an expandable list of the Device types. 

4. In the Property Grid, expand the Pipe Design section 

5. In the Fluid Zone field, select Water at 60 F and 75 psig(Water at 15 C and 517 kPa) and then click 

outside the field. 

a) Notice that when all selected devices have the same value, it is displayed in the field. 

6. In the Specification field, select Steel Sched 40 

a) Notice that the field now says Steel Sched 40. This allows the Pipe Size to be Group Edited as 

well. We'll come back to this below. 

7. Group Edit the Names of the remaining Pipes:  

a) With all the Devices selected, de-select the Suction Pipe by holding down the CTRL key then 

clicking on the Suction Pipe. 

b) In the Name field, enter 10-TW-1, then Enter. 

c) Notice that all the selected Pipes take the new Name format, but the last number is incremented 

by 1 to create a unique name for each Pipe. 

8. Group Edit common Pipe Sizes 

a) Click on an empty space on the FLO-Sheet to de-select all the Devices 

b) Hold down the CTRL key and select Pipes: 10-TW-1, 2, 3 and 4 

c) In the Size field of the Pipe Design section of the Property Grid, select 6 in (150 mm), then 

Enter 
d) Notice that these four Pipes now show that they are 6 inch (150 mm) 

  

 



Enter the Remaining Design Data for the Pipes 

1. Using the table below, enter the Lengths and Valves & Fittings for the remaining Pipes. 

 

Calculate the Model 

Now that all the Devices in the model have the required Design Data, the system can be calculated and the 

results evaluated for each Device and the entire system. The results can be evaluated using the information 

selected for display on the FLO-Sheet and in the List View Window, but the first results that should be 

evaluated are any Messages that are generated in the Messages Window. 

Calculate the model by either: 

1. Click the Calculate button  on the View Toolbar, or 

2. Select Calculate from the System Menu, or 

3. Click F5. 

To clear the results, click  again, F5, or select Calculate from the System Menu again. 

Evaluate Messages 

There are five (5) levels of messages based on the calculated results. Level 0 messages are generated if results 

cannot be calculated based on how the system is designed. Level 1 messages mean the results are invalid, Level 

2 indicated increased uncertainty in the results, Level 3 messages are generated if user-entered limits are 

exceeded, and Level 4 are informational messages about the status of devices. 

To view the Messages: 



1. If the Message Window is not displayed, from the View Menu, select Messages from the Windows 

drop down list. 

2. The Message Window shows what Device(s) is causing the message, what the message is, and a link to 

a page in the Help File that explains the message and what can be done to resolve the problem that is 

creating the message. 

There should only be one message generated at this point in the tutorial. This should be a Level 4 message 

describing the Number of Iterations and the % Deviation of each iteration. If you have any other messages, 

review the previous sections of the tutorial to determine what was entered incorrectly. 

Evaluate Calculated Results 

For each element in the piping system you can find both design information and calculated results on: 

 the FLO-Sheet, 

 the Property Grid Results section for each Device, or 

 the List View Window 

Property grid 

 This is the only place where design information can be added or edited 

 When you point to something on the FLO-Sheet the Property Grid automatically shows the information 

about the selected item 

List View 

 You can see the results of like elements and compare them together 

 The list can be sorted by any heading 

 Columns can be re-arranged or hidden  

FLO-Sheet 

 This is to provide important information 

 Best way to see the results in context of the entire system 

 Information for individual items can be hidden or displayed based on the objective of the calculation 

 Excellent presentation look with objective on big picture. 

Select a Centrifugal Pump 

With the piping system model in the Calculate Mode, the Total Head and NPSHa results for the Sizing Pump 

can be used to select a Centrifugal Pump from over 95 pump manufacturer catalogs developed by Engineered 

Software, Inc. and supported by the software. 

The software will step you through the selection process, automatically searching through the selected catalog. 

Once the pump is selected, the pump performance data is automatically imported into the model and the Sizing 

Pump is converted into a Centrifugal Pump. 

http://www.eng-software.com/pml/default.aspx


Generate a Pump Selection List

 

1. Verify the model is in Calculate Mode with the calculated Total Head displayed as 260.8 ft (79.5 m). 

2. Right Click on the Transfer Pump and choose Select Catalog Pump from the right click menu to open 

the Pump Selection dialog box. 

a) The Fluid Properties section shows the key fluid properties from the Fluid Zone of the pump's 

inlet pipe. 

b) The Search Criteria section displays the Flow Rate, Total Head, NPSHa, among other criteria. 

This criteria can be edited once a catalog is selected. 

3. In the Select Catalog section: 

a) Click to expand the list of pump catalogs that are installed on your 

computer.  

i. To download additional catalogs, click on the Download Pump Catalogs link to go the 

Engineered Software website. 

b) Choose Sample Catalog.60 from the list. 

i. Notice that the Types and Speeds boxes are now populated with those available in the 

catalog. 

ii. Also notice that the Edit Search Criteria box is activated. 



 

4. Click on the Edit Search Criteria button to open the Search Criteria dialog box. 

a) decrease the Total Head value to 240 ft (73m) to add a design margin. 

b) Enter 62.13 ft (19m) for NPSHa 

c) Enter a NPSH Margin Ratio of 1.3 

d) Enter a Preferred Operating Range from 60 to 120 percent of flow at BEP. 

e) A Secondary Operating Point can be entered, along with a motor type and motor Sizing 

Criteria. Leave these as they are for now. 

f) Click to accept the new Search Criteria. 

5. In the Types section, check the box beside ESP and HSC. 

6. In the Speeds section, check the box beside 3600 and 1800. 

7. A list of pumps that meet the Search Criteria is displayed, along with a thumbnail of the pump curve 

with the design point marked. 

a) Click on the Eff (%) column heading to re-order the list by pump efficiency in ascending order. 

Click it again to re-order the list in descending order. 

8. Double click on the ESP 4x3-13 row to open its Pump Curve. 

a) The pump Speed (3550 rpm) and recommended impeller Diameter (8.125") (206 mm) to 

achieve the design point are displayed. Note that the value of Total Head with this diameter is 

245 ft (76m), which is greater than the search criteria of 240 ft (73m). 



i. Click the down triangle beside the impeller diameter to reduce the size to 8"(200 mm). 

Notice that the pump curve drops and the value of Total Head at this diameter is only 

229 ft (70m), which is less than the required Total Head. 

ii. Click the up triangle to increase the impeller diameter back to 8.125" (206mm).  

b) New Flow or Head values can be entered and the results displayed in the Data Point section. 

This does not change the design point used in the Search Criteria. 

9. Click  to close the dialog box. 

Select a Pump and Transfer Pump Data to the Model 

1. Click on the ESP 4x3-13 

line to highlight the row. 

2. Click to return the pump data to the model and change the Sizing Pump into a 

Centrifugal Pump. 

3. The POR and NPSH Margin Ratio are not brought in from the Search Criteria, so these have to be re-

entered. 

a) Enter 60 in POR From field. 

b) Enter 120 in POR To field. 

c) Enter 1.3 in the NPSH Margin Ratio field. 

Evaluate Calculated Results 

1. Notice that the flow rate through the Transfer Pump is now around 617 gpm (140 m3/h), which is less 

than the design flow rate of 1600 gpm (363.4 m3/h). 

Use Lineups to Evaluate Different Operating 

Conditions 

Once the Design Data is entered for each Device, different operating conditions can be evaluated using the 

Lineups feature. The Operation and Setting of Devices can be changed, Pipes can be closed, and Fluid Zones 

can be modified. 

The initial Lineup is called the <Design Case>. An unlimited number of Lineups can be created and Lineups 

can be re-named, copied, and deleted. Lineup Settings can be changed while in the Calculate Mode. 

 



Create a New Lineup 

 

1. Click the Edit Lineup button in the Lineup Toolbar  to open the Lineups 

dialog box. 

2. Click to add a Lineup. 

3. Select the new Lineup and click . 

4. Rename the Lineup "Minimum Flow". 

5. Click to close the Lineups dialog box. 

Change Lineup Settings 

Place the system in Calculate Mode, then: 

1. In the Lineup Toolbar, select Minimum Flow from the drop down menu. 

2. Select the Supply Tank on the FLO-Sheet and change the Liquid Level to 8 ft (2.4 m). 

3. Select the Duplex Strainer, then: 

a) In the Property Grid, click in the Curve field to activate the button. Click on to open the 

Curve Data dialog box. 

b) In the Description field, enter Plugged Strainer. 

c) Click on the to open the Curve Data Estimator dialog box. 

i. In the Static Pressure Drop field, enter 0 psi. 

ii. In the Flow Rate field, enter 400 gpm (91 m
3
/h). 

iii. In the Pressure Drop field, enter 25 psi (172 kPa). 

iv. For the Maximum Flow Rate, enter 800 gpm (181.7 m
3
/h). 

v. Click to close the Curve Data Estimator dialog box. 

d) Click to close the Curve Data dialog box. 

4. Evaluate Messages 

a) With the system in Calculate Mode, review the Messages created with this operating scenario 

using the Messages Window. 

i. Pump running outside of preferred operating region. 

b) Click the Help ID link in the Messages Window to open a description of the message and what 

is causing it. 



Reset Lineup Settings 

1. Select the North Tank on the FLO-Sheet 

2. Change the Surface Pressure to 25 psig (172 kPa) and the Liquid Level to 10 ft (3 m). 

3. In the Lineups Values Window, for the Minimum Flow Lineup, click on the Reset button . 

4. Notice that the Surface Pressure and Liquid Level are returned to their <Design Case> Lineup values. 

Use Graphs to Visualize Data and Performance 

There are several graphs that can be opened to visualize the hydraulic performance of various Devices, 

including Centrifugal Pumps, Pipelines, Flow Meters, and Curve dP Devices. The System Resistance 

Curve can also be graphed. 

Pump Graph 

1. Right click on the Transfer Pump and select Graph... from the right click menu to open the Pump 

Graph. 

2. Click on the Graph Settings... button to open the Graph Display dialog box. 



1. In the Pump Curves section, check Catalog, Envelop, and Design Curve. 

2. In the Optional Curves section, check Efficiency and Power, and either ISO or Line under 

each. 

3. In the Graph Elements section, check Grid Lines, Design Point, Design Guides, and Selection 

Window. 

4. The color of each line can be changed. 

5. Click to close the Graph Display dialog box. 

3. Click within the allowable operating range for the given impeller diameter to view the associated values 

for that Data Point. 

4. Increase and decrease the Speed and Diameter to see the effect on the pump curve. 

5. Click to close the pump graph without applying the changes to the pump performance. 

Pump Graph with System Resistance Curve 

The Pump Graph can also be printed with the System Resistance Curve. 

1. Right click on the Transfer Pump and select Graph resistance curve... from the right click menu to 

open the Pump Graph. 



2. Click  to close the pump graph. 

Pipeline Graph 

The system must be in Calculate Mode to view the Pipeline Graph. 

1. Right click on any pipeline and select Graph from the right click menu to open the Pipeline Graph. 

2. Click to open a text file containing the data that was generated to create the graph. This file 

can be saved if desired. 

3. Click to close the data text file. 

4. Click to close the Pipeline Graph. 



Curve dP Device Graph 

The system does not have to be in Calculate Mode to view the Curve dP Device Graph. 

1. Right click on the Duplex Strainer and select Graph from the right click menu. 

2. Click to open a text file containing the data that was generated to create the graph. This file 

can be saved if desired. 

3. Click to close the data text file. 

4. Click to close the Curve dP Device Graph. 

Enhance the Presentation Value of the FLO-Sheet 

There are various features that allow you to customize the look of the FLO-Sheet to help you highlight key 

information or to make your model drawing look similar to a Process Flow Diagram or Piping & 

Instrumentation Diagram (P&ID). 

1. Presentation Mode can be toggled on to remove the grid and show the system on a white background. 
2. Device Symbols can be changed and re-sized. 



3. The Text for individual Devices can be shown or hidden and the font, style, size and orientation can be changed. 
4. Floating Text can be placed anywhere on the drawing, allowing you to freely annotate various areas and objects 

in your system. 
5. Images can be placed on the FLO-Sheet, moved and re-sized. 
6. Rectangles can be drawn around objects and sections of the system to highlight particular pieces of equipment, 

operation areas, and landmarks. 
7. Notes and Links can be added to each Device to include additional information. 

Add an Image to the FLO-Sheet 

1. Click the Image button in the Toolbox and click on the upper middle area of the FLO-Sheet. 
2. Navigate to the Sample Systems folder under My Engineering Files>Projects. 
3. Select the OlyPumps Logo.bmp file and click Open. The image is placed on the FLO-Sheet. 
4. The image can be moved to the desired location and re-sized.  

NOTE: You can re-size the image by clicking and dragging the green squares on the corners and sides 

of the images. The corners keep the ratio of length to height locked in, while the side and top and bottom 

squares will stretch the image. 

Add Free Floating Text to the FLO-Sheet 

1. Select the Text button  

2. Click at the top center of the drawing to place a Floating Text box on the FLO-Sheet. 

3. Enter Building HGF-2 in the Property Grid . 

4. Click  beside Font below the text entry box of the Property Grid to open the Select a Font dialog 

box. 

a) Select Arial as the Font. 

b) Select Bold for Font Style. 

c) Select 16 as the Size 

d) Check the Underline box. 

5. Click to close the Select a Font dialog box. 

Add Notes and Links to Devices 

Notes and Links can be added to Devices to document additional information that is not included in the Design 

Data fields. 

Add a Note and Link to the Duplex Strainer 

1. Select the Duplex Strainer. 
2. In the Property Grid, scroll down to the Notes section. 
3. Click the Notes field to open the Editor dialog box. 

a) Click the Edit tab. 
b) Enter the following text: "Manufacturer recommends cleaning strainer basket when pressure drop 

reaches 15 psi." 
4. Select the word Manufacturer 

5. Click to open the Hyperlink dialog box. 



a) Type in the following URL: www.eng-software.com 

b) Click to close the Hyperlink dialog box. 
6. Click the View tab to view the Note and Link. 

a) Click the hyperlink that was created to open the web page (if you have internet access). 

7. Click to close the Editor dialog box. 
8. There is now an asterisk (*) to the left of the first line of text for the Duplex Strainer indicating that the Device 

has a Note. 

Adjust Text Settings for Devices 

The Device View Options are used to select what Design Data and Calculated Results to display on the FLO-

Sheet for each Device when the text is shown. 

With the Text Settings, unnecessary or repetitive text can be hidden individually for Devices or using the 

Group Edit feature, leaving just the text that the user wants to highlight. In addition, the text font, style, size, 

and orientation can be changed to emphasize key information. 

Hide Unnecessary or Repetitive Text 

1. Select pipe 10-TW-1 at the discharge of the Transfer Pump. 

a) Expand the Text Setting section of the Property Grid, then un-check the Show Text box to 

hide the text for this individual pipe. 

Change Text Font, Style and Size 

1. Select the Transfer Pump 

2. In the Text Settings section of the Property Grid for the pump, click inside the Font field to activate 

the button. Click to open the Select Font dialog box. 

a) Scroll down the Font list and select Arial. 

b) Select Bold Italic as the Font Style. 

c) Select 10 pt as the Font Size. 

d) Click to close the Select Font dialog box. 

Change the Device Symbols and Sizes 

Once the piping system is drawn, the Device Symbols and Sizes can be adjusted if desired. 

Change Device Symbols 

Device Symbols can be changed using the Symbol Settings section in the Property Grid for each Device or by 

right clicking on the Device to open the right click menu. 

1. Change the Transfer Pump Symbol 

a) Right click on the Transfer Pump and select Change Symbol to open the Symbol dialog box. 



b) Select the In-Line Centrifugal Pump symbol and click . 

2. Change the North Tank symbol 

a) Right click on the North Tank and select Change Symbol. 

b) Select the Pressurized Tank symbol and click . 

c) Repeat for the South Tank. 

3.  Change the Curve dP Device symbol 

1.  

a) Right click on the Curve dP Device and select Change Symbol 

b) Select the Duplex Strainer symbol and click . 

Change Device Sizes 

Device Sizes can be adjusted individually using the Symbol Settings section in the Property Grid for each 

Device or the sizes of multiple Devices can be changed with the Group Edit feature. 

1. Select the Flow demand. 

2. In the Property Grid, click on the triangle beside Symbol Settings to expand this section. 

3. Click in the Symbol Size field to open the drop down menu and select 75%. 

4. Click on the FLO-Sheet or Enter to accept the change. 

View the FLO-Sheet in Presentation Mode 

1. Click the Presentation Mode button on the View Toolbar. The FLO-Sheet grid lines are removed and a 
white background replaces the gray background. 

2. Click Presentation Mode again to display the FLO-Sheet with a gray background with grid lines. 

 


